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Introduction to 
MapInfo ProViewer

Welcome!

Congratulations on your choice of MapInfo ProViewer, the easy way to see, 
print, and share electronic desktop maps. This convenient map viewer opens 
tables created using Pitney Bowes MapInfo products such as MapInfo 
Professional, MapX, or MapXtreme and displays them in Map and Browser 
windows. It also opens workspaces and re-creates Map, Browser, Graph, and 
Layout windows exactly as they were created in MapInfo Professional. Using 
this product you can display and print maps and workspaces created in any 
version of the Pitney Bowes MapInfo product line. 

The purpose of this chapter is to familiarize you with the basics of MapInfo 
ProViewer and provide resources for you to become familiar with it. You can 
also get installation assistance from Technical Support, if necessary, using 
information in this document. 
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Installing MapInfo ProViewer
To install MapInfo ProViewer:

1. Click the Start button.
2. Click Run and type or browse to the ProViewer setup.exe file. Click the OK button to begin the 

installation. The Welcome screen appears.
3. Click Next to continue to the License Agreement dialog box.
4. Click I accept the Terms and click Next to display the Customer Information dialog box. 

Complete these fields with appropriate entries to continue.
5. Click Next to display the Destination Folder dialog box.
6. In this dialog box, click Next to accept the default path or click Change to select a new path. The 

Ready to Install dialog box displays.
7. Click Install to begin the file transfer. The Installing dialog box appears. 

Note The .NET framework is installed as part of the MapInfo ProViewer 9.5 installation.

8. When The InstallShield Wizard Completed dialog box appears, click Finish to complete the 
installation of MapInfo ProViewer.

What’s New in MapInfo ProViewer 9.5?
This section contains information about the new features of ProViewer 9.5. Please note that due to 
the extensive additions to the maps and layout features, .tab files and .wor files created in MapInfo 
Professional 9.5 cannot be displayed using the ProViewer 9.0 product. These are the new features 
you may see in your 9.5 maps:

• New WFS-T Functionality
• Enhanced Labels Improve the Look of Your Maps
• Pen Clause Added to Text Statement
• Coordinate System and Datum Enhancements
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New WFS-T Functionality
Proviewer 9.5 allows the user to open 9.5 version .tab files that are related to the new WFS-T 
functionality.

Who Can Read .tab Files Created Using WFS-T

At Pitney Bowes MapInfo, we try to keep .tab files as backward compatible as possible to preserve 
your investment in our product. Some of the changes to the WFS-T do not allow us to do this for 
MapInfo Professional 9.5. Below are these cases and their file format requirements. 

Enhanced Labels Improve the Look of Your Maps
In Proviewer 9.5,  you can open up MapInfo Professional .wor files containing maps with enhanced 
labels.

Labels Look Better in MapInfo Professional 9.5

You may notice that the rotated and horizontal labels that display in your maps look better. We have 
incorporated a new anti-aliasing process that is based on the latest graphic rendering technology. 
This technology helps us improve the realism of your map by removing the "jagged" label and text 
display in low resolution maps.

These label enhancements are also visible in the Layout window, the Browser window (although not 
the Redistricter window), and the Legend window.

If you open a WFS-T Layer and
Then is this table compatible with previous 

versions of MapInfo Professional? 

Save it locally and do not select the 
Allow Edits check box 

Yes, pre-9.5 MapInfo Professional users can 
read this .tab file 

Make changes and commit them to 
the WFS-T server 

Yes, pre-9.5 MapInfo Professional users can 
read this .tab file 

Make changes and do not commit 
them to the WFS-T server 

No, pre-9.5 MapInfo Professional users cannot 
read this .tab file 
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Horizontal Labels with Enhanced Rendering Set to None

Horizontal Labels with Enhanced Rendering Set to Anit-Alias
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Pen Clause Added to Text Statement
In MapInfo Professional 9.5, a user can now change the style of the leader (or "callout") line 
associated with a text object. In the example below, the callout has a dashed, red line style.

Saving this text object, in a .wor file will produce a 9.5 version .wor file. Proviewer 9.5 can then open 
the new .wor file.

Coordinate System and Datum Enhancements
Added Belgian EPSG Code. We have added a new EPSG Code:

• Belgian National System (7 parameters)\p31370

Added Croatian Coordinate System. We have added the following coordinate system:

• Gauss Kruger zone 5

Added Egyptian Coordinate System. We have added the following coordinate system:

• Egyptian Transverse Mercator

Added Estonian ESPG Codes. We have added EPSG Codes for Estonian coordinate systems:

• L-EST97 (EUREF89)\p3301
• L-EST 1992 (EUREF89)\p3300
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Added Fijian Coordinate Systems. We have added the following coordinate systems:

• Fiji Map Grid (WGS72)
• Fiji Lat/Long(Viti Levu - Clarke 1880 datum)

Added Finnish Coordinate Systems. We have added the following coordinate systems:

• Finnish Coordinate Systems (2003) Finnish KKJ Zone 0 through Zone 5
• Finnish Coordinate Systems (Old, 1996) Finnish KKJ Zone 0 through Zone 5
• Finnish Coordinate Systems (Old, 1990) Finnish KKJ Zone 0 through Zone 5

Added French Coordinate Systems. We have added the following coordinate systems:

• Lambert I Carto - Paris (Borne monde)\p27571
• Lambert II Carto - Paris (Borne monde)\p27572
• Lambert III Carto - Paris (Borne monde)\p27573
• Lambert IV Carto - Paris (Borne monde)\p27574
• Lambert I Nord - Paris (Borne monde)\p27561
• Lambert II Centre - Paris (Borne monde)\p275620
• Lambert III Sud - Paris (Borne monde)\p27563
• Lambert IV Corse - Paris (Borne monde)\p27564

Systèmes français Méridien de Paris (Borne Europe) (V7.8) 

• "Lambert I Carto - Paris (Borne Europe)\p27571
• "Lambert II Carto - Paris (Borne Europe)\p27572
• "Lambert III Carto - Paris (Borne Europe)\p27573
• "Lambert IV Carto - Paris (Borne Europe)\p27574
• "Lambert I Nord - Paris (Borne Europe)\p27561
• "Lambert II Centre - Paris (Borne Europe)\p27562
• "Lambert III Sud - Paris (Borne Europe)\p27563
• "Lambert IV Corse - Paris (Borne Europe)\p27564

Systèmes français Méridien de Paris (Borne France) (V7.8) 

• "Lambert I Carto - Paris (Borne France)\p27571
• "Lambert II Carto - Paris (Borne France)\p27572
• "Lambert III Carto - Paris (Borne France)\p27573
• "Lambert IV Carto - Paris (Borne France)\p27574
• "Lambert I Nord - Paris (Borne France)\p27561
• "Lambert II Centre - Paris (Borne France)\p27562
• "Lambert III Sud - Paris (Borne France)\p27563
• "Lambert IV Corse - Paris (Borne France)\p27564

Systèmes français RGF93 - Méridien de Greenwich (Borne monde)

• "France Lambert-93 (Borne monde)\p21540

Systèmes Français RGF93 - Méridien de Greenwich (Borne Europe) ---"

• "France Lambert-93 (Borne Europe)\p2154
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Systèmes français RGF93 - Méridien de Greenwich (Borne France

• "France Lambert-93 (Borne France)\p2154

DOM-TOM IGN

• "Réunion, RGR92 - UTM 40S - IGN\p2975
• "PDN-Gauss Laborde Réunion-IGN\p2990
• "Antilles Françaises, RRAF1991 - UTM 20SN - IGN\p2989
• "Guadeloupe, Ste Anne- UTM 20N- IGN\p2970
• "Guadeloupe, Fort Marigot- UTM 20- IGN\p2969
• "Martinique, Fort Desaix- UTM 20- IGN\p2973
• "Guyane, RGFG95 - UTM 22N - IGN\p2972
• "Guyane, CSG67- UTM 22N- IGN\p2971
• "Guyane, RGFG95 - UTM 21N - IGN\p3313
• "Guyane, CSG67- UTM 21N- IGN\p3312
• "Nouvelle Calédonie, Grande Terre - UTM 58S - IGN72\p3060
• "Nouvelle Calédonie, Maré - UTM 58S - IGN53\p2995
• "Nouvelle Calédonie, Lifou - UTM 58S - IGN56\p2981
• "Mayotte, Combani1950 - UTM 38S - IGN\p2980
• "Mayotte, RGM04 - UTM 38S - IGN
• "Mayotte, Cadastre 1997 - UTM 38S - IGN
• "St Pierre et Miquelon - UTM 21N - IGN1950\p2987

Systèmes français Méridien de Greenwich (MIW avant 3 - Obsolète) 

• "Lambert I Carto - Greenwich (Obsolète)
• "Lambert II Carto - Greenwich (Obsolète)
• "Lambert III Carto - Greenwich (Obsolète)
• "Lambert IV Carto - Greenwich (Obsolète)
• "Lambert I Nord - Greenwich (Obsolète)
• "Lambert II Centre - Greenwich (Obsolète)
• "Lambert III Sud - Greenwich (Obsolète)
• "Lambert IV Corse - Greenwich (Obsolète)

Réunion IGN

• "Réunion, RGR 92 - UTM 40 sud - IGN 1989\p10012
• "PDN-Gauss Laborde Réunion IGN\p4626

LABORDE Madagascar

• "Laborde Madagascar (mètre)
• "Laborde Madagascar (kilomètre)
• "Laborde Madagascar

Added German Coordinate Systems. We have added the following bounded coordinate systems:

• Gauss-Kruger (DHDN) bounded Zone 1 through 5
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Updated Irish Coordinate System. We have updated our Irish Coordinate System as follows:

• Irish Grid
• Irish Transverse Mercator (ITM)

Added Libyan Coordinate Systems. We have added the following coordinate systems:

• LTM 2 Zone 5 through 13
• LTM 2 Zone 13
• UTM Zone 32 (LGD 2006) through UTM Zone 35 (LGD 2006)
• LTM 16

155 - A new Datum for Libya (LGD 2006) its parameters:

Ellipsoid - International

ShiftX = 208.4058 m
ShifYy = 109.8777
ShiftZ = 2.5764 m

Added Netherlands Coordinate System. We have added the following bounded coordinate 
system:

• Netherlands National System (mm acc)

Added Polish Coordinate Systems. We have added the following coordinate systems:

• "PUW 42/GK Zone (Pulkowo 1942)\p3333
• "PUW 42/GK Zone 4 (Pulkowo 1942)\p3334
• "Poland ETRS89 / CS92\p2180
• "GUGiK 80\p3328
• "Universal polar stereographic (WGS84)
• "Polish Lambert conformal
• "1965/1\p3120
• "1965/2\p2172
• "1965/3\p2173
• "1965/4\p2174
• "1965/5\p2175
• "ETRS89 / Poland CS2000 zone 5\p2176
• "ETRS89 / Poland CS2000 zone 6\p2177
• "ETRS89 / Poland CS2000 zone 7\p2178
• "ETRS89 / Poland CS2000 zone 8\p2179

Added Romanian Coordinate Systems. We have added the following coordinate systems:

• Romanian Stereo 1970
• Romanian Transverse Mercator
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156 - Dealul Piscului 1970 datum for Romania

Krassovsky Ellipsoid #3
Shift X = 28
Shift Y = -121
Shift Z = -77

Added Swedish Coordinate System. We have added the following coordinate system:

• ST74\p3152

Added Turkish Coordinate Systems. We have added the following coordinate systems:

• UTM Central Meridian 27 Zone 35 (ED50)
• UTM Central Meridian 30 (ED50)
• UTM Central Meridian 33 Zone 36
• UTM Central Meridian 36 (ED50)
• UTM Central Meridian 39 Zone 37 (ED50)
• UTM Central Meridian 42 (ED50)
• UTM Central Meridian 45 Zone 38 (ED50)
• GK Central Meridian 27 (GRS80)
• GK Central Meridian 30 (GRS80)
• GK Central Meridian 33 (GRS80)
• GK Central Meridian 36 (GRS80)
• GK Central Meridian 39 (GRS80)
• GK Central Meridian 42 (GRS80)
• GK Central Meridian 45 (GRS80)
• UTM Central Meridian 27 Zone 35 (GRS80)
• UTM Central Meridian 33 Zone 36 (GRS80)
• UTM Central Meridian 39 Zone 37 (GRS80)
• UTM Central Meridian 45 Zone 38 (GRS80)

Features Added in Previous Versions of ProViewer
This section provides a history of the previous changes to the ProViewer product. 

New in ProViewer 9.0
Curved Labels Improve the Look of Your Maps. We added curved labels as a new feature in 
MapInfo Professional 9.0. Curved labels are labels that follow the curve of streets, rivers and other 
linear map features as shown in the next figure. Maps created with curved labels can be displayed in 
ProViewer and older maps can be modified in MapInfo Professional 9.0 to display this new 
functionality. However, older maps do not display this feature automatically and you cannot use 
ProViewer to display curved labels if the map has not been created using this feature. If you open a 
map with curved labels in an older version of ProViewer, you will get an error.
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New Data Sources May Display in Version 9.0 Maps. In MapInfo Professional version 9.0, Pitney 
Bowes MapInfo partnered with a third-party vendor named Safe Software and incorporated some of 
their Feature Manipulation Engine (FME) technology. This gives MapInfo Professional 9.0 users 
more flexibility in creating maps using the following data sources:

• ESRI ArcSDE
• ESRI Personal Geodatabase (*.MDB)
• AutoCAD.DWG/DXF
• Microstation Design (*.DGN)
• ESRI ArcInfo Export (*.E00)
• USGS Spatial Data Transfer Standard (*.CATD.DDF)
• VPF NIMA/NGA (*.FT)

Timeand Date Time Data May Display in Version 9.0 Maps. If your organization maintains time- 
or date and time-specific data, your map creators may use a new time and date time functionality to 
display this information in your thematic maps. Using this new feature your new maps can display 
time-sensitive data thematically.

Using the Find Command in Remote Tables. The Find command (Select > Find) is available for 
linked remote tables, regardless of whether they are indexed. Neither the table nor a column in the 
table needs to be indexed for the Find command to be available. 

If the selected column in the search table does not have an index, an index will be created when you 
click OK in the Find dialog box. For native tables and linked remote tables, this newly created index 
is permanent.

Multiple HotLink Capability Added. We added the ability to access more than one HotLink 
definition per map object. When you click a map object with multiple HotLinks, a list of options are 
displayed, which allows you to access different types of content for a single map object. 

Homeland Security Fonts Added. Your map creators now have access to new standard fonts 
prepared by the Office of Homeland Security. These fonts were developed to standardize the way 
emergency circumstances and industries are depicted in maps. Specifically the new symbols are:

• Incidents - These fonts show various hazardous circumstances such as fires, police activity, 
and other dangers.

• Infrastructures Stage 01 - 04 - These fonts show various industrial environments including 
farms, factories, financial businesses etc. in a wide variety of complex frames to indicate severity

• Natural Events - These fonts show areas of natural disasters such as hurricanes, tsunamis, 
volcanoes and other natural events 

• Operations Stage 01 - 04 - These fonts show various emergency circumstance symbols such 
as ambulances, biohazard, and Red Cross-type symbols in a wide variety of complex frames to 
indicate severity

New Projections and Coordinate Systems Supported. The following are the projections and 
coordinate system enhancements for this version:

• Added Bosnia-Herzegovina Coordinate Systems. We have added the following projections:
• Bosnia-Herzegovina (Zone 5) 
• Bosnia-Herzegovina (Zone 6) 
• Bosnia-Herzegovina (Zone 7) 
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• Added Luxembourg Projections. We have added the Luxembourg 1930 / Gauss\p2169 
Luxembourg projection.

• Added S-JTSK (KROVAK) Coordinate System. We have added a new S-JTSK projection to 
serve the Czech Republic and Slovakia. We have added using new Projection #32 and new 
Datum #1020.

• Added Swedish Coordinate System. We have added the ST 74 projection.
• Updated EPSG Aliases for Swedish Coordinate Systems. We have added two new EPSG 

aliases for Swedish coordinate systems to the PRJ file to maintain consistency with the latest 
update to MapXtreme:
• EPSG:2326
• EPSG:3152

• Updated Hong Kong EPSG Code. We have added the Hong Kong 1980 Grid System\p2326 
EPSG code entry.

• Updated Australian Victorian Coordinate System. We have added the following Australian 
bounded projections:
• VIC VicGrid66 (AGD 66)
• VIC VicGrid94 (GDA 94)
• VIC AMG Zone 54 (AGD 66)
• VIC AMG Zone 55 (AGD 66)
• VIC MGA Zone 54 (GDA 94)
• VIC MGA Zone 55 (GDA 94)
• VIC Longitude/Latitude (AGD 66)
• VIC Longitude/Latitude (GDA 94)

• Updated Danish Coordinate System Entries. We have added the following Danish 
projections:
• UTM Zone 32 Euref89\p25832
• UTM Zone 33 Euref89\p25833
• UTM Zone 32 (ED 50)\p23032
• UTM Zone 33 (ED 50)\p23033
• System 34 Jylland-Fyn\p34003
• System 34 Sjaelland\p34005
• System 45 Bornholm\p45001
• KP2000 Jylland-Fyn\p18401
• KP2000 Sjaelland\p18402
• KP2000 Bornholm\p18403

New in ProViewer 8.5
More Room on the Status Bar. We have enlarged the Status Bar cursor location and file name 
fields to ensure that this information is more readable. We have also simplified the coordinate entry 
to display in decimal degrees.

Printing Large Images Improved. Customers printing large images (such as destination page size 
D, E, or A0) previously reported problems using MapInfo ProViewer. Some of the printing problems 
stemmed from a 28,000 pixel limitation that we have addressed in this version of MapInfo 
Professional. Pitney Bowes MapInfo no longer supports the Windows 95 or 98 operating systems, 
which allowed us to remove this restriction.
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Better Support for GRD Files. MapInfo Professional 8.5 added a new preference that allows you to 
display Vertical Mapper GRD maps as grid files and not as raster files. Vertical Mapper creates 
GRD\TAB files that display using the raster handler. The new preference contains a Grid option, so 
you can view Info tool information about 3D GRD maps.

Raster Image Reprojection Enhanced. In MapInfo Professional, we added automatic image 
reprojection for registered raster data such as satellite and aerial photo images, scanned maps, 
grids, seamless tables and WMS data. Previously, map professionals were restricted to reprojecting 
the vector maps. You are now able to view maps created using this feature. 

AirPhoto Raster Handler Upgraded. We have incorporated the latest AirPhoto Raster Handler 
4.23 into the 8.5 release of MapInfo Professional. You are now able to review map files created with 
this new AirPhoto format.

Coordinate System Enhancements. The following are the coordinate system enhancements for 
this version:

• ETRS-based Coordinate Systems Added. We have added the following ETRS-based 
projections to our PRJ file: Transverse Mercator Zone 26-39, Lambert Conformal Conic, and 
Azimuthal Equal Area. 

• Lithuanian and Latvian Coordinate Systems Added. We have added the following Latvian 
Coordinate Systems to the PRJ file: LKS-92, and Longitude/Latitude (LKS-92). We have added 
EPSG codes to the following Lithuanian Coordinate Systems: LKS-94, Baltija-92, Longitude / 
Latitude 
(LKS-94) and KS-1942 Zone 4.

• Estonian Coordinate System Added. We have added the following Estonian Coordinate 
System 
L-EST 97.

• Swedish Coordinate System Added. We have added Swedish Coordinate Systems for 
Aviation maps.

• South African Coordinate System Zones Added. We have added several Gauss Kruger 
Coordinate System zones.

New Help System Enhancements. We have updated the MapInfo Professional Help System to 
provide new functionality that you may already be using in other Microsoft products.

• Reading help topics gets easier. When you click in a help topic you can use the mouse wheel 
to scroll up and down through the topic as you read. This is the quick way to get through help 
topics and move on to getting your work done.

• Type too small? Zoom in! If you press and hold the Ctrl key while you use the mouse button to 
scroll through a topic, the type displays in a larger font so you can read the text clearly.

• Access to the most current MapInfo Professional documentation is easier! At the bottom of 
each help topic, there is a web address that takes you to the Pitney Bowes MapInfo web page. 
From there you can get the latest MapInfo Professional documentation or peruse documentation 
for other products. You must be connected to the Internet for this feature to work.

• Can’t find a favorite topic? Save it in the Favorites tab! You can store topics you refer to all 
the time on a Favorites tab, which persists from session to session. 
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To save a favorite topic in the Favorites tab:

1. Open the Help System by doing one of the following:
• Click Help in a dialog box 
• Select Help > MapInfo Professional Help Topics

2. Click the Search tab and display the topic you want to save.
3. Click the Favorites tab and click Add. The Help System adds the topic to the list.

New in ProViewer 8.0
Autoscroll now more consistent. The T key is now used to toggle Autoscroll on and off. It used to 
be that A turned Autoscroll on and T turned Autoscroll off.

More Nodes. Increased the number of nodes permitted per object for regions, polylines, and 
multipoints.

Added support for the ASRP version 1.2 raster format.

Added New Datums, Projections and Ellipsoids including:

• Chinese Coordinate Systems
• Guernsey Grid Coordinate System
• Hellenic Geodetic Reference System
• Baltic Projections (Lithuanian and Latvian)
• New Zealand Geodetic Datum 2000
• New Belgian Coordinate System
• Additional British National Grid Coordinate System

New Grid Handler. Added the Arc Grid Handler to support the use and display of ESRI grid files.

New in ProViewer 7.8
Improved File Handling. Open MapInfo Professional 7.8 workspaces and table files. This includes 
.tab files referencing ESRI Shapefiles and table files containing new projections.

WFS and WMS Support. View workspaces and .tab files that reference Web Map Service (WMS) 
and Web Feature Service (WFS) layers.

Large Crosshair Selection. Support for selecting nodes more precisely.

Supports Larger Excel Files. Open .tab files that reference larger Excel files (more than 32K rows).

Enhanced Centroid Snap Capabilities. 

Enhanced 3DMap Viewing. Improved PrismMap lighting.

Removed 255K character limit in Layout and Map windows in workspaces.
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Upgraded raster handlers. Upgraded the LeadTools to version 13, MrSID SDK (3.2) to provide 
support for MG3 files and updated the current raster handlers to handle multi-threading; specifically 
for ECW and the Government handlers (ADRG, ASRP, CADRG, CIB, NITF).

New in ProViewer 7.0
Microsoft Windows-like File Open Dialog Box Support Added. You can now use My 
Documents, Desktop etc. button options that have been added to the File Open Dialog Box.

ESRI Shapefile Support Added. You can now open .tab files that reference ESRI Shapefiles.

Raster Format Support Added. You can now open .tab files that reference ECW, MrSid, JPEG 
2000, ADRG, CADRG, CIB and NTIF raster format files.

Displaying a Map in MapInfo ProViewer
To explore the basics of desktop mapping concepts, let’s explore the World.wor workspace, which is 
installed with ProViewer.

To display a map in the ProViewer product:

1. Click the Start button, select the All Programs, MapInfo and MapInfo ProViewer to display the 
ProViewer window.

2. Click the  button or from the File menu, select Open button to display the Open MapInfo 
Tables or Workspaces dialog box.

Note You cannot open .MWS files created with MapInfo Professional in ProViewer.

3. Click the Data directory and click Open.
4. Click the World directory and click Open.
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5. Select the World.wor entry and click Open to display the World workspace.

Understanding the ProViewer Toolbar
The toolbar icons at the top of the MapInfo ProViewer window can help you perform mapping work 
easily and efficiently. The Help System contains a detailed explanation of each icon.

Icon Name Icon Name Icon Name

Open Print Help

Select Zoom In Zoom Out

Change View Grabber Info Tool

Drag Map Window Ruler Show/Hide Legend

Label HotLink Show/Hide Statistics

Select Boundary Marquee Select Radius Select
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A Brief Tour of the World.wor Workspace
Use the World.wor to review the map layers and experiment with these icons to become familiar with 
their functionality. You can think of a workspace as a map with transparencies stacked on top of it. 
Each layer contains data that pertains to the entire map. For example, World.wor includes the 
Ocean, the Countries, and the World Capitals layers.

Using the Select Icon

This is the  Select tool’s default cursor. Position the cursor over any region to display the name 
of the region. There are several selection icons that allow you to select map features and group 
regions for display. See the Help System for more about the specific properties of each icon.

Select Polygon Graph Select Unselect All

Invert Selection

Icon Name Icon Name Icon Name
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Using the Statistics Icon

Click the  Statistics icon to display more about a selected country in the Statistics window.

Using the Ruler Icon
The Ruler tool can show distance between two points on a Map window.

1. Choose the  Ruler button and position the cursor, which displays as a cross, anywhere on 
the map and click. 

The Ruler window displays Distance and Total. As you move the cursor, the Distance 
measurement changes in the Ruler window. 

• To measure the distance between two points, click the first point and double-click the 
second. 

• To measure the length of a path containing two or more segments, continue the process, 
clicking once at the end of each segment to keep a running total of the length of the path.
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Using the Zoom Icons
The Zoom options give you control over the display of the Map window.

1. Open a Map window and click the  Zoom in button. Position the cursor anywhere on the 
map. 

Full featured Pitney Bowes MapInfo products allow you to determine the range (for example 
0 to 3 miles, 2 to 5 miles) at which each layer is visible in a Map window. 

2. To see the effect of zooming click the Zoom in icon anywhere on the map. The map redraws at 
the new zoom level. Notice that the information changes in the Zoom section of the Status Bar 
to reflect a new zoom level. 

3. To specify the zoom level of the map, click the  Change View button and enter a new zoom 
level. 

At different zoom levels, new information displays on the map reflecting the visibility of the 
different map layers that comprise World.wor.
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Displaying the Map Legend
The map’s legend explains the meaning of the different shapes, colors, and fill patterns. 

1. Open a Map window and click the  Legend button or select the Options menu and the 
Show/Hide Legend command.

Note Not all maps have legends.

2. Choose the Map menu option and the Previous View command to return the map from the 
beginning.

We have provided the icon descriptions, the Glossary, and the online help to support you as you 
navigate through more mapping adventures!

Getting Online Help
Use ProViewer‘s comprehensive online Help, including sections on menu commands and dialog box 
descriptions, to answer your ProViewer questions.

Getting Technical Support 
If you encounter problems installing MapInfo ProViewer, our technical support specialists can help. 
Technical Support for MapInfo ProViewer is limited to installation issues. For workspace-related 
issues, see the MapInfo Professional user who created the workspace. 
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For questions concerning the installation of ProViewer, contact Technical Support at (518) 285-7283 
or visit the Pitney Bowes MapInfo website (www.mapinfo.com).

Want to do MORE?
Consider...

MapInfo Professional, the premier desktop mapping product for business and government. MapInfo 
Professional allows users to access their own data to see relationships between data and 
geography, answering questions such as...

• Where are my best customers located?
• Where should I place my next sales office?
• How can I increase my sales?

MapInfo Professional answers these questions in a straightforward manner, reducing the time it 
takes to make smarter decisions.

http://www.mapinfo.com


Glossary

This section contains a list of terms we use to describe ProViewer features and 
capabilities.

A
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Term Definition

Browser A window for viewing a table (or a database, a spreadsheet, or a text file) 
in tabular form.

Coordinate An X,Y location in a Cartesian coordinate system or Longitude/Latitude 
location in an earth coordinate system. Coordinate systems represent 
locations on a map relative to other locations. Earth coordinate systems 
may use the Equator and the Greenwich Prime Meridian as fixed 
reference points. Plane coordinate systems describe a two-dimensional 
X,Y location in terms of distance from a fixed reference point and are 
usually in the first quadrant so that all coordinates are positive.

Degrees of Longitude, 
Degrees of Latitude, 
and 
Decimal Degrees

Degrees (longitude and latitude) are coordinates used to represent 
locations on the surface of the Earth. Longitude (or X coordinate) 
represents a location’s east-west position, where any location west of the 
Prime Meridian has a negative X value. Latitude (or Y coordinate), 
represents a location’s north-south position, where any location south of 
the Equator has a negative Y value.

Field A field in a table corresponds to a column in a Browser. A field contains a 
specific type of information about an object, such as:

• Name
• Abbreviation
• Land Area
• Price
• Population etc.

The record for each object consists of the object’s values for each of the 
fields in the database.

Graticule A grid of horizontal (latitude) and vertical (longitude) lines that display on 
an Earth map spaced at a regular distance (for example, every five 
degrees, every fifteen degrees). Used to establish a frame of reference.

Latitude The horizontal lines on a map that increase from 0 degrees at the Equator 
to 90 degrees at both North (+90.0 degrees) and South (-90.0 degrees) 
Poles. Used to describe the north-south position of a point as measured 
usually in degrees/minutes/seconds or decimal degrees above or below 
the Equator.

Legend The part of a map that explains the meanings of different colors, shapes, 
or fill patterns used on a map. A legend can also include a scale.
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Longitude The vertical lines on a map that run from the North to the South Poles, 
used to describe the east-west position of a point. The position is reported 
as the number of degrees East (0 to -180.0 degrees) or West (0 to +180.0 
degrees) of the Prime Meridian (0 degrees). Lines of Longitude are 
farthest apart at the Equator and intersect at both Poles, and therefore 
are not parallel.

Map Scale A statement of a measure of the map and the equivalent measure on the 
earth. Often expressed as a representative ratio of distance, such as 
1:10,000. This means that one unit of distance on the map (for example, 
1 inch) represents 10,000 of the same units of distance on the earth. 

Map Window A window that allows you to view a table as a map.

Node An endpoint of a line object, or an endpoint of a line segment which is part 
of a polyline or region object.

Raster A type of computerized picture consisting of row after row of tiny dots 
(pixels). Raster images are sometimes known as bitmaps. Aerial 
photographs and satellite imagery are common types of raster data found 
in GIS. A computer image can be represented in raster format or in vector 
format. 

Record All the information about one object in a database or a table. A record in a 
table corresponds to a row in a Browser.

Selection A data item or set of data items chosen for inspection and/or analysis. In 
Browsers, and in Map windows, items can be placed in the selection set 
by clicking on them individually. Map windows also have special tools for 
selecting multiple items on a spatial basis.

Status Bar A bar at the bottom of the screen that displays messages that help in 
using MapInfo ProViewer.

Table Information databases are organized as tables. Tables are made up of 
rows and columns. Each row contains information about a particular 
geographic feature, event, etc. Each column contains a particular kind of 
information about the items in the table. MapInfo Professional tables can 
contain graphic objects representing geographic objects. Such tables can 
display as maps.

Toolbars Windows that contain a variety of buttons used to access tools and 
commands for mapping and drawing. 

Vector A coordinate-based data structure commonly used to represent map 
features. Each object is represented as a list of sequential x,y 
coordinates. Attributes may be associated with the objects. A computer 
image can be represented in vector format or in raster format. 

Term Definition
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Workspace A saved configuration of open MapInfo Professional tables and windows. 

Zoom Layering A setting that determines the range (for example, 0 - 3 miles, 2 - 5 miles, 
etc.) at which a layer is visible in a Map window. 

Term Definition
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